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Getting Started: Formatting Your Schedule

CHOOSE THE TAB TO:

1.Set the schedule’s Date Range.

2.Set Page by Page Date Range.

3. Set options for Fiscal Year.

4.Set Saturday, Sunday and Holiday Shading.

5.Set the schedule’ Holiday Calendar.

6. Current Date from computer or choose to override.

7.Display the Current Date.

8. Display the Current Date Line.

@ File Connections Edit Dates Insert Layout Format

zplayed Start Date
9/1/2013

@ Displayed End Date
8/31/2019

—L"I—:

Maore Settings_ [

Ho
=] Shift Settings
lg‘ Start and End Dates More Date Settings

9. Display the Status Line.
10. Change Date and Status Line attributes - More current date options.

11. Have Symbols & Bars Fill to Status Date
12. Choose Four-Digit Years.
13. Set the Symbol Date Format.

Choose the - Full Dialog

button to find more options
14. Set the schedule’s Date Headings. for a feature.

Make sure to press the =) APPLY buttons after entering
the parameters for the schedule.

View Tools Selection @ Help
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Mgpre Cument Date Options: [=) Set Symbol Date For E(@
w rrent Date Date Related Settings

Ster SChedule 6. Current date
e 7. Display date | > 6/23/2016
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Getting Started: Formatting Your Schedule continued

CHOOSE THE J¥:V{elVill TAB TO:

1. Set the Chart Size. 7.Set the three possible DataGraph heights.
2.Set the Margins. 8.Setup Summary Bars.
3. Eliminate Automatic Top Margin. 9.Setup Baseline. Choose the - Full Dialog button to find more op-
. . tions for a feature.
4.Set the Rows Per Page. 10.Set Duration options.
5. Set the Orientation. 11.Global Symbol Size change. Make sure to press the APPLY buttons after
6.Set the Legend Height. entering the parameters for the schedule.

=1

Z] File Connections Edit Dates Insert Layout Format View Tools Selection @H elp
D

. Printer _— Enter Legen pm=— Summary Bar | === Set Be
n Chart Size: o 16.0 Vert 11.0 Orientation Lzndscape @ Height 0.7 =¥Grzph Show =] Sertings s

E“'\‘"i :[ Left 0.5 Right 0.5 ‘d;l; 5 changes, pre: Urdox k(155 B Bazcline = =
visrgins 2 Settings —
Top 0.4 Bl 0.5 | Apply Setting Changes | "] 0.00 ' g
anore Autematic Top Marg & 0,00 uratio
Ignore Automatic Top Margin Emrt;;r symbd oce
Al Lock Layout Rows per Page 12 Full Page Layout Dislog: [ Full Legend Setting= [ ) Full Datagraph Dizslog: [ L
EF Page Size Legend Size DataGraph Sizes Other Row/Symbol Sizes
‘ T
2. Margins - white space around chart CAMPUS MASTER PLAN - 9711
Preliminary Cash Flow Projection I3. Eliminate auto top margin for less white space
2018 2019 * suzy '
Phase Duration ot | a2 [ a3 | a ot | e [ w3 | e ot | @ [ e [ a Costs
Totals 442d | : ] 414 $25,400
"""""""""""""""""""" {1[! Duration l ' '
Schematic Design s GTRY 5 $4,450
R
"""""""""""""""""""""""""""""" 1. Chart Size Custom 16"11"
Design Development 85d 126 TRY TS 4. 12 task Rows Per Page $5,030
"""""""""""""""""""""""""""""""" 5. Orientation - Landscape
Construction Documents 130d 113 QTR 1 $5,200
Permitting 86d - 1 25 $10,220
7777777777777777777777777777777777777777777777777777777 |9. Baseline I
11. Symbol Size Custom .8
Bidding and Negotiation 77d 1-“0:){; Y $500
Totals [B. Summary Task 524d az2 [ : 11. Symbol Size also $14,855
....................................................... L controls bar's width ...
Construction Phase 1 179d Rl 7 7 gl $3,545
N e
Construction Phase 2 150d 10-19?;'2&'6 $1,865
Construction Phase 3 57d 18 Ay u2 $3,025
_______________________________________________________ L e
Construction Phase 4 84d 5114 QLR b5 $3,020
_______________________________________________________ R e
Construction Phase 5 54d ai8 Ry 928 $3,400
| —
Construction Costs 511,045 54322 §7 687
Construction Costs [
| 2000
s 7. DataGraph 000 o
Total Costs 7,000]
- ] N o I M [
I — B e B
Planned . Baseline
| — =
$ZZZZp Planned Summary Baseline = Summary

To learn more about the tab features choose: Help | Help Topics | Milestones Professional Help
Select the Index tab and type in the feature. For Example Baseline.
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Getting Started: Formatting Your Schedule continued

CHOOSE THE §AS4:48 TAB TO:

1.Insert a Chart Title. 8.Insert a Legend Entry.

2.Insert a Page. 9.Insert a Vertical Links. Some of the features on the Insert menu are advanced
. features you may not use in the first schedules you

3.Insert a Page Break. 10.Insert a Recurring Tasks.

build. However, knowing the location of these fea-

4. Insert a Task Row 11.Insert a Baseline tures will help you as you become a Milestones Pro-
fessional power user.

5. Insert multiple Task Rows. 12.Insert a DataGraph.

6. Insert a New Column. 13.Insert a ValueSet.

7.Insert a Picture.

File Connections Edit Dates Insert Layout Format View Tools Selection @ Help

[ S

m Insert/Edit 3 ValueSet @

Rows, Columns Picture, Legend Vertical Links Recurring Task Baseline, DataGraph, ValueSet UniquelD

Project Status Report

Baseline vs. Current Costs

E]V Title @

Page 10f 2 €—|2_|nsert Pages I
m 2018 2019 Cost

Shace Variance

- | DEL DEL DEL DEL DEL 6. SmartColumn l
Deliy 10. Recurring Task | 015 015 015 <>15 <>15 _

Phase 1 ¥ (51,119
11. Baseline

= $0

Phase 2 T ¥ $352
4. Insert Task Row
Phase 2 5- Insert Multiple Task Rows _ = _ ¥ ($991)
; 30 (s ks #
Wl

Phase 4 ; 1 = $0

9. Vertical Links '

Phase 5 ! *:| = $0

Baseline Costs
$4. 000l
ICurrent Costs
12. DataGraph
13. ValueSets
- Baseline Track Revised Jeaak JJ Current Status <> Delivery
[T ET 8. Legend Entries
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Getting Started: Formatting Your Schedule continued

CHOOSE THE Je)i{7/:VY TAB TO:

1. Apply a Color Theme. 7.Change Background Color, Border, Frame Corners.
2.Add Vertical Gridlines. 8. Clear Shadows, Highlights.

3. Add Horizontal Gridlines. 9. Change Symbol Size.

4. Add Curtains. 10. Set International Number and Currency.

5. Add Holiday Shading. 11. Set-up Gridlines, Shading, Font Sizes by Outline Level.

6. Change Default Text.

Ii‘ File Connections Edit Dates Insert Layout Format View Tools Selection e Help

I,
-- Vi Gridlines C Chart

[ Personal Themes hd Undo Color Theme: u = x - @
g D

Aquacoal - [Use Schedule Shading
Black and Blue |_|

Blue & Beige =
Blue Bird

Bluebonnet
BlueSand

Symbol Text

ymbol Notes . Symbao Sz—

Color Themes Gridlines Vertical Shading @k{mll Text Frame, nghllgl'vls International

1. Color Themes determine the color of School Construction Schedul(4- Curtain 7. Background Color,
various schedule elements, like the title box, F HH . Border Frame, Corners
symbols and bars. legend etc. prehensive Facility Master Plan - Propose plan
v
2017 -
March | April | May | June | July | August |September| October | November | December
Work Element Cost
[ [ [ |
Reviews Q|g:f"mm P sl 1 L Q@i TEEl | @|aL 2= 10. International Number and Currency I
' | i |
8. This symbol has Shadows and i NS
Strategic Highlights that can be tumned off ations. 9. Symbol Size | £30,000
Make a global change to the schedule's '
Space Utilization Survegllr - [| symbols size. Symbol size also £25,000
controls horizontal bar width. ‘
Collect Current Data [ A
[ - ' 5. Holiday Shading
Compile Electronic Backgrounds | : Set the holiday calendar =
[ (E)CurrPgm: "7 )| Curriculum Program Lidzleesas
2. Vertical Gridlines | : _Bdg Use Opts_|
Building Needs | Exterior Docs | FM Database £20,000
Life Safety/Accessibility :
3. Using Horizontal Gridlines and Shading 4 task _
rows can be made to look like one orange swim lane. [ SystemsReview [ FM Database] :
_) Building Needs Assessment
L [ Planning Analysi 1 000
WEBS Task — L aiod aalvsis | 6. Default Text Setthe style, ﬁ
tanuary [ February | March | April | May 1 |color, and size for each text element
1 |Project A <J _ 1> on the schedule.
21 | Event1 ‘ f
111 Task 1 v 7 Growth Options
O — | '
112 Task 2 v L
———
1.1.3 Task 3 v v .
1.2 Event 2 i
121 Taskl ¥ 11. Assign features to tasks based on their outline level using the
122 Task 2 option: GRIDLINE, SHADING, FONT SIZES BY OUTLINE LEVEL.
2 |Proejct B <] =
21 | Event1
211 Task 1 v W
2.1.2 Task 2 ki v
e — |
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Getting Started: Understanding Your ToolBox

Arrow Tool - Use to select, change or move
objects on the schedule.

Plus Tool - Use to add ToolB Text Tool - Use to add text
information to the schedule. \4, ~ T/anywhere on the schedule.

[l

il g

Small Plus- Select to add the cor- ¥ | <= Drawing Tools - Use to draw lines,
responding symbol, bar, symbol = ——shty——na circles or squares.
combination to the schedule. + |
T h —
hd e _1 Horizontal Bar - select to add between
_+ | E===—— symbols on the schedule.
Symbol - select to add to —satp | | %
schedule. FY
T.—] Hide Toolbox

Right cIan the TOOLPQXto £ Toolbox Properties...
change its characteristics. | g .
[ Switch to Standard Toolbox
i —
+ | = Copy Toolbox Set up a toolbox to your standards . Then copy and
I P paste it to another schedule. Both schedules must
+ | =1 Paste Toolbox . . .
=== be opened in the same instance of Milestones.
el [ —
— Copy Selected Row i
+|o ] Py £ .
—1 T, 1= Paste Copied Row over Selected
. . | I'. L]
Vertical Link - select to add R4 _ _ Set-up a row in the toolbox that then can be cop-
between symbols on different =5 = Sidebar Options...  |ied and pasted to another row in the toolbox or
task rows. \ e \ ] another schedule’s toolbox. Both schedules must
" Turn on Tooltips be opened in the same instance of Milestones.
Double click any Symbol, Horizontal Bar or Vertical Link in the toolbox to change its charac-
teristics: (Shape, Type, Size, Color, Markings, Position, Text and Date display).
Symbeol Options =m== Vertical Link Options ==
Sample Symbal: 1220 Options for Current Vertical Link
Color:
Symbol Shape | ColorjPattemn/Size shadow | Text and Date Propertes | Default Text
Line Pattern:
Standard Shapes: User Defined Shapes: Letter Marking -
N - ( - Shape:
C:YJse..nDocuments Bar Options =]
[EF]30 Lok [Tl mbed Above Symbol in e Sample Bar: BEFORE STATUS (Complete):  AFTER STATUS (Incomplete): s -
Clipping Symbol for printing: -
D:I:D Flcoor: [ ] Flcoor: [ ] Ar_rowhead Typ?:
@ Mormal () Trianglar
Ears:F\\Il;Sch;‘msEOn‘PrEss Line Colar: El 2 -/ Triang
@) Normal Symbol . . Options for All Vertical Links
) Comment Symbal Ganored for SmartColumn purposes) BTz FillPattern: Fillattern: ihead
© status Sy (s o Percen: Campie) ;e - EEEEEE - N - e ot tee
(©) Baseline Symbol (used in Baselines) Bar Types preceded with & Line Pattern: B B -
e e - Cadpst for crart sy sie
setting. [] Show on top
[ 5,:EDE| Effects: E;fregtef E;f;(;
fore ] Color: — Color: — [~ Rounded Corners
|| Draw lines for page spanning Vertical
Connections
Arrowhead Size (Arrow Bars Only)
sl ® Normal © Large || braw Off-page Connection Bubbles
[7]3-D Look for Bubbles
Shadow Settings (Bars Only)
] Show Shadaw Shadow Size: IE Small TS
Shadow Color: Medium
[— Lo [ ooy | [ ox | [ concel |
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Getting Started: Add Information To Your Schedule

Add a Slngle Symbol = 201 ToolBox
1. In the toolbox, select the Large Plus tool. anary |4 ] ey ]S Jwaren |L1_>+‘ AT
February | March + L\"H _g_ 2 :I O
2.Select a symbol in the toolbox. v : + o
7 Pk ——y
3. Move the cursor to the schedule area . ~T 1

4. Click and drag horizontally.

5. Let go of the mouse button at the selected symbol date.

To see the date next to the cursor, Tooltips in the Schedule area need to be
turned on. Tool | Help| uncheck No Tooltips in the Schedule area

Add a Horizontal Bar With a Start and End Symbol

1.In the toolbox, select the Small Plus at

201 ToolBox
the beginning of a row. The entire row in fanuary | February 283 | | - | ” | ‘ T
the toolbox will be highlighted in blue. U A s et e e
| .
2. Move the cursor to the schedule area. L. ¥ L1
Saturday 2/18/2017 —
3. Click on the start date and drag horizontally. @ = %7
4. Release the mouse button on the end date.
Add a Horizontal Bar
1.In the toolbox, select the Small Plus at Jamary February ToolBox
the beginning of a row with null symbols 1+ 6T
and a horizontal bar. The entire row in w0 | | 15 283 | | ey | March | ~JOlO
the toolbox will be highlighted in blue. + |1
2. Move the cursor to the schedule area. ol K Y
@ saturday 2/18/2017 L
3.Click on the start date and drag horizontally. 38d 1 |=—
—
4. Release the mouse button on the end date. ri
Til:l

To set up a horizontal bar in the toolbox. Set the symbols on the right and left side of a toolbox row to Symbol Shape 28 (null
symbol). For the bar in the center bar us Bar Type 2, 5 or 7.

Add a Bar and Symbol to an Already Existing Symbol in the Schedule

1.In the toolbox, select the Large Plus
| Fi ToolBox

tool. fanuary

2.Select a symbol in the toolbox. 17 jj | @ | 1 i
Febr March
3.Select a connector in the toolbox. Ianuary | February @ K
4. Move the cursor to the schedule area and . O Saturday 2/18/2017
click on the already existing symbol. ? T 32d

5. Continue to hold the mouse button and
drag horizontally.

-
-

Wi

!

6. Let go of the mouse button at the desired date.

|
l

|-|+|++++|++/l
iR
O
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Getting Started: Add Information To Your Schedule

Add a Horizontal Bar Between Two Symbols Already on the Schedule

1.In the toolbox, select the Large Plus tool.

— — 2| ToolBox
b
2.In the schedule area, click once on the Symbol ———" [ rebrary 23 [ rond [ | waq =R T
from which you want the horizontal bar to " 2 EE' 21\6 L Nini[e)
begin. |
+
3.In the toolbox, click once on the Horizontal sanuary | February | Lﬁ
Bar to be used. jhd 5T,
1}? 21 ?
4.In the schedule area, click once on the Symbol
which completes the horizontal link.
Add a Vertical Link Between Symbols 3] Toolox
1.In the toolbox, select the large Plus tool. po— o] — wary [ 3w ] Mm{LF +&|T
2.In the schedule area, click once on the X 2y A iz ~ OO
symbol from which you want the horizon- ~ =———= |
tal to begin. . o » ) e | 2| =3
+
3.In the toolbox, click once on the Vertical |l
Link to be used. +| ==
2 | ===
4.1n the schedule area, click once on the symbol which completes the s o
vertical link. (Must be on a lower or higher row) P ‘I
A
Add Column Text (1) Add Symbol Text (2)
1.1n the toolbox. select the Text 1. With the arrow tool, click the symbol on the schedule. The toolbar will
tool. change to the Selection tab.
2.Click in the column or column 2.Choose the Text tab.
heading box on the schedule and 3.In the Text section, enter up to 3 lines of text in the Text Line 1, 2, or 3.
start to type.
4. Click the APPLY TEXT CHANGES button.
T 2016

1]
Add COLUMN TEXT A" —

SYMBOL TEXT
Moves with o symbol
3z three lines thatcan be formattad it

Add FREEFORM TEXT
anywhere on the schedule  Add Symbol Notes (4)
L 1. With the arrow tool, click the symbol

January |Fehmaw| March | — | wiay | e | ) 5.In the TEXT PLACEMENT section, select
2 the positioning of the text.

SYMBOL NOTES

Moave with a symbol
Add Freeform Text (3) on the schedule. The toolbar will Can be displayed, hidden, formatted,
1.In the toolbox, select the Text tool: change to the Selection tab. E}> e e
Gan have pictures
2.Click anywhere on the schedule and 2.Choose the Notes tab.
start to type.

3.In the Symbol Note section, type in
your notes.

3.Select the freeform text. In the
toolbar make changes to its attrib-

utes. 4. Click the Apply Text Changes button.

The symbol can display a highlight or
number to show that it has a note

5.Select from the variety of formatting options.

6. Use the directional pad to reposition the symbol note or the arrow tool to drag
the symbol note to a location.
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Getting Started: Change Information On Your Schedule

Change a Symbol on the Schedule - . T
1.In the toolbox, select the Arrow tool. 2016 f? . J—> A
. | February | March | April | May | February | L\ '_J:h | April | May 1 3 L
2.In the schedule area, click once on a Symbol that
you want to change. u W e uY
3.In the toolbox, click once on a different Symbol. R — Lv A -

Using the shift key you can select a
group of symbols to change.

Change a Bar on the schedule

1.1n the toolbox, select the Arrow tool 2016 e
.In the toolbox, select the Arrow tool. —
! 2016 uary | |2 |ar\r | March | April | May 1_‘r T
2.In the schedule area, click once on the Symbol v | February | March | April \ May Nuife]
14
that begins the Horizontal Bar you want to -« VI %_ﬂ—f’
"""" v b —Y
change. i : —
: A | P =
. . . AV — +
3.In the toolbox, click once on a different Horizon- +
tal Bar. -
*
Change a Vertical Link on the schedule 016 ol
1.In the toolbox, select the Arrow tool. —
2016 | February | | 2 I;h | April | Mav"‘_}-}. T
2.In the schedule area, click once on the Sym- | February | March | April | Ma Olo
bol atop the Vertical link that you want to 1
change. o A o
3.In the toolbox, click once on a different verti- Xﬂﬁ
cal Link.

On the Schedule Change any Individual Symbol’s Properties
1. Using the arrow tool, in the toolbox select the symbol. 5 ..

W] oo, |w o
2.The toolbar will change to the Selection tab for that H o o | o
. . & Thu  4f5/2018 @ g E] oee
symbol select the tabs to change its attributes. c:o' ﬁ 9 Blell :
. B comec e comy By T See/tolor [ Summan/Viark [ Notes ] Wypbinks || Conshaines ]| Symbel ks || Valussers [ | Verdal links

3.Select the Text tab to change the text size, color, font,

date format and/or the position of the text or date. Task T P B B BTSN BRI o e e e e
4. Select the Size/Color tab to change the symbol’s color, Thsk1 [ -

size, vertical position on the task row.
5.Select the Summary/Mark tab to change the Symbol Mark and its color.
6.Select the Notes tab to add notes to the symbol and change the characteristics of the note.
7.Select Hyperlinks tab to add URL’S or link files to the symbol.
8. Select Constraints tab to add specific actions to the symbol like, lock symbol to this date.
9. Select Symbol Links tab to add links between symbols on current schedule, another schedule or a task in a Microsoft Project file.
10. Select the ValuesSets tab to add a value to the symbol for Symbol ValueSet Datagraph

11.Select the Vertical Links tab to override the vertical links color.

9 of 14



Getting Started: Change Information On Your Schedule

Override the Color of a Bar on the Schedule
1. Using the arrow tool, in the toolbox select the starting
symbol of symbol, bar, symbol combination on the sched- . % |

=]
ule. The toolbar will change to the Selection tab for the g vor o @[] 0

starting symbol. fine _ 5@ e )
[ connect o copy [y Y 7om Tl | SormanMark [ | Notes [ Hypeinks

File  Connections  Edit  Dster  Inset  Llayout  Format  View  Tools  Selection (@ Help

Resst } [ ]a

Current Object: =
Symbol (1 Selected)

sz o fhione <]

T vellow
m

2. Select the Size/Color tab.

‘Task ! -

° . . o ‘r"""\ﬂ larcl il la une ul Ugus eptember|
3.In the Override Symbol and Bars Colors section click on — o] e | sen [ wey | wme | wv | aves peosemeed
the rectangle box next to 1st Bar Color to display the & [ awi | o | wune | iy | vest e nVE———Ax
color pallet. sa v:;i Eg_ .
4. Choose the new color. S ——

Override the Color and or Line Type of a Vertical Link on the Schedule
1. Using the arrow tool, in the toolbox select the starting sym- [ s comectons  eat  oates r@
bol of the vertical link. The toolbar will change to the Se- B

layout  Format  View  Tools  Selection = (@ Help

om it The finks coming from this symbol are

e Current Object:
Symbol (1 Selected)

= Row. Sym
s s = - Te
lection tab for the starting symbol. g = — — —_
- et Break in _ Hq: Bresk Lnk | [gf2 Break Link | [ Break ik | [=
2. Select the Vertical Links tab. = L e = B o e e | e e
3.In the Vertical Links from the Current Symbol sec- 2018
March | April ‘ May ‘ June | July ‘ August ‘Seplember| Octol

tion find the link to be changed. Each symbol can
have up to five vertical links.

4. Choose the new color and/ or line pattern.

Override the percent complete of a symbol, bar

SymbOI Combination [©Z] File  Connections  Edit  Dates  Insert  Layout  Format  View  Tools Sa\ectlor‘\_g\ Help
. . . o Lo Otascl Key 2 size from 10 to 5.00 = ° 4 "

1. Using the arrow tool, in the toolbox select the starting =t '

symbol of the symbol, bar, symbol combination. The

. - . 2 r Color: ) [
toolbar will change to the Selection tab for the starting 5 ome Syt an o Coors 5%
& [l | Surnmary/Mark [ | Notes || Hyperinks || Constraints [ | Symbel Links niqs-y: rtical Links |
symbol. o
47%
2018 8%
2.Select the Si I Task : 5
.Select the Slze/CO or tab. January ‘February‘ March | April | May ‘ June ‘ July ‘ Augun%<4H October |\
52%
: . TASK 1 o Py — T 2R e -
3.In the Override Symbol and Bars Colors section choose Egg:;; i
the drop down next to the 1st bar Fill %. 2018 =
tanuary [February [ Morch | April | May | wme [ v | August [september] octaber [N
4. Select a new percent. D] - » It 1 [ ] »
i ,
Change an Existing Column’s Type st
1.In the toolbox, select the Arrow tool. Column 10 Heading
. . Deselect Bt Dat Insert  Llayout  Format Vi Tool Select
2. Click the column heading of the column you want to change. The e e e
. . Date: Start Date E =1r
toolbar will changes to the Selection tab. | [—r— n
5 Date: End Date

! Date: Baseline Start

Date: Baseline End

Date: Status Date

Date: Date from Symbol with Matching Automation Tag..

4.In the Column Type and Format section choose the down arrow Curation: Total Duration...
. . K Duration: Remaining Duration...
next to the Properties button. Pick from the available column types.

3. Click the Switch to Column icon.

Move a Column

1.In the toolbox, select the Arrow tool. 2 — ﬁ
LJ 3 i
2. Move the cursor to the top of the column heading's border. The cursor changes 5113”; Endg =
to the Column Move cursor. End Status
3.Click and drag to the new location, as shown by the Insertion cursor. sr1ameEl 2mamniaE
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Getting Started: Change Information On Your Schedule

-2 Shift all Dates by a Number of days
@ 1.0n the toolbar, click the Dates tab.

2.In the Date Range Tools section click the Shift all task dates icon.

3. Enter the number of days. Choose Forward or Backward.

Date Range Tools

Hide/Show All Symbol Dates and/or Text Yiew  Tooks _adedtion
1.0n the toolbar, click the View tab. S

2.In the Other section, click Override Symbol Text and Symbol Date Display . ™ symbol'ta'gs e =)

+ Show a

Task Rows
symbols G Redraw Screen
il Items Other
CONVERT SYMBOL TEXT TO SYMBOL NOTES
1. On the Format tab choose Symbol Notes to first set up symbol notes’ default ] b
settings. TEAT DEMED:L
| L
2.Choose the Tools tab. In the Other Tools section, choose Convert symbol Text '
to Note Text... ' : TEXT ON SYMBOL

3. Select symbols to convert.

4.Select how to convert.
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Getting Started: Working With Other Products

CHOOSE THE {go/\'/\'/Ta[e)i'" 3 TAB TO:

1. Copy Metafile (picture) to the Clipboard
Milestones is placed into another application as a picture.
2. Copy Schedule to the Clipboard
Milestones is placed into another application as a picture,
text or object (can be linked and will update when the
actual Milestone file is changed).

10. Copy all Pages to PowerPoint
Picture of multiple page Milestones schedules will be cop-
ied into an already existing or new PowerPoint document.
11. Copy PowerPoint Slides from Project
The Project to Milestones Wizard will open. The Mile-
stones Professional schedule is generated. It will be copied
to PowerPoint.

@ File Connections Edit Dates Insert Layout

3 =F mt Lefres| shy C 2ges eate 3 ErNE E 'n z
C froje s 4] ry . asks or ar  blis| Hh B chedule fr
a I Wizan XML File
=0 D= N SHve]
A Zve Custom Project Manzge Custom Export to Project Export Tasks to D Refresh Highghting
Ternplate Project Templates Outlook e
Clipboard

Microsoft Project Microsoft P Microsoft Outlook Other

3. Create Report from Project
The Project to Milestones Wizard will open. Step through the
wizard. A Milestones Professional schedule will be generated.
4. Create Report from Project Server

- tosk  Taskname LMS Project File.mpj
Open Project Server then choose this option The Project to i° il Y=
Milestones Wizard will open. Step through the wizard. A Mile- v
stones Professional schedule will be generated. 5 %
5. Refresh Previously Imported Project e

Refresh a file imported from, or tagged to, a Microsoft Project
or Microsoft Project server file or files. :
Build a refresh list for a Milestones files tagged to multiple

Microsoft Project or Microsoft Project Server files.

6. Refresh Highlighting G e e
Refreshed schedules can have the change symbols highlight- -
ed . Select this option to turn off the highlighting.

7. Save Custom Project Template Learn More: Help |Help Topics choose the
Choose this option to save a customized Milestones Profes- | Index tab type in keyword Microsoft Project.
sional schedule to have it included in the import wizard.

8. Manage Custom Project Templates

Choose this option to view and manage all your Custom Pro- 9. Export t9 Pro!ect . .
ject Templates. Choose this option to create a Microsoft Project schedule

from a Milestones Professional schedule.

200days  11/2012  12/12/2012
S0days  1y012  5/3/2012
a1days  sa/02  6/29/2012
16days  8/9/2012  1/31/203
2adays  7/202  6/6/2013
0days 702 /1R
S0days /22012 3/7/2013
%0days 21203 6/6/2013
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Getting Started: Working With Other Products continued

<?xml version="1.0" encoding="UTF-8" standalone='

3 = <eroject xmlns="http://schemas.microsoft.com/pro!
= <saveversion>l4</Saveversion> T ———
5 race.xml</Name> - = =

il il O i vuWORN ‘""" gy N AN RN
= a - smStart>1</ScheduleFromSt. -
— .998-01-02T08:00:00</8tar
—_— ~2001-06-12T717:00:00</Fin.
— :>1</Frscarcbate>

Gantt Schedule of Upcoming Meetings for November 9-8 ickLimit>0</Criticalslack
Generated from Outlook Calendar Information jits>2</CurrencyDigits>
o Tz Tz /i 30 1bol>$</CurrencySymbol>
[l o] o [ [ [ [ EIEEIEIEIECD 1e>USD</CurrencyCode>

RN ST <CurrencySymbolPosition>0</Currencys

o ot <CalendarUID>1</CalendarUID>

s <DefaultStartTime>08:00:00</Defaults

A e <DefaultFinishTime>17:00:00</Default

] [ s

8 ot

wianF]

o]

5 @t

NT— R T
12. Import Outlook Tasks or Calendar 15. Export Schedule to XML file
The Outlook information is imported into a set Milestones Choose from a variety of export options.

templates which can be modified after the import. 16. Import Schedule to XML file
13. Export Tasks to Outlook Generate a schedule from a Primavera saved XML:MS

Pick the column of information from your Milestones Project schema file with the XML Project to Milestones
schedule to import as the description for the dates that Import Wizard. _ _
will be placed into your Outlook Task List. Choose from other XML import options.

@ File Connections Edit Dates Insert Layout Format View Tools

Expon Task:
emplates Outleok
Microsoft Project Microsoft Pi Microsoft Outlook Other

2 Miestones rofessions - ContactStatus Reviewirle] Eloes
W Fle | Connections | Edit  Dates Inset  Layout Format  View  Tools  Selection (@ Help _lelx

3 - 14. Internet Publishing Wizard

Choose to create schedule graphics and HTML pages-

~re

s s ready for your web site.
ToolBox b
Contract Status Report [+ T
N\
R — e O If your schedule has links to other schedules or docu-
ED Contract Status Report . .
Apves | 121 Hi—s ments hotspots will be created. Also, any Milestones
o . . .
o man s schedules that are linked will also be published as HTML
ProjectA e vl ¥ A — Delivery 2012 Ahead /
— | T LR % i or s s o e et e o Tl pages.
Project B 1024 —r—v—v% . 5 QD E -
v — 1213 [ ]
Project C 12113 v Al Contract Status Report
o ——
2
= = [
™, ) |
Pl § P2 P3 P4 - Delivery 2012 3
etz oo =
FroRE - (\..-7 Ll on | e | ir | or oy [un | u | a0 Contract Status Report
o
— Baseline = ProjectsSummary ¥ Phase End Al Projects 1213 \:;:;:?:.:E
o peey ® enna scneaue @ Anesaor b ; -.‘j
i P1 P2 A P3 P4
Proet e , e reen,
Page 1of 1 & BP1 P2 P3
s BESEINE === project Summary Project B 10124 Sy —v—v— A rroecs 12113 o oo | @ > 1a%
B Deiivery ® Behind Schedule -
- 1213 ——— ProjectA 1 —y—vew——yp P‘A e O m
X e —— —
If hedule is outlined t t of (- 7 -
your schedule is outlined, you can create a set o | | e | o |7 o =
v P2
Uy . ” %!
HTML pages called a “tiered hierarchy | .. Al e e ez | o2 = @ O o
. . . ol Phase 3 4125 Y ® D 4%
with multiple HTML pages for each outline level. e —, o ~
Phase 4 715 l: 0O O o%
" | : Delivery @ Benind Schedule @ Anead of Sche A
@
o Gmseine = progcisummay ¥ praseEnanisone A TS 4§ Curent
B Delivery ® Benind Schedule @ Anead of Schedule O On Schedule:
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Getting Started: The File Tab

CHOOSE THE §Z/¥3 TAB TO:

1. New 2. Wizard
Choose New Empty Schedule to B 55 N~ ) Guides you through setting | e
open the blank default tem- ) New Empty Schedule : up a schedule using Step
plate. Clone Current Schedule.. by Step or a Predesigned
Chose Clone Current Schedule Template.
to create a new schedule from Close menu
an existing schedule.

[ File

Insert Layout@ﬁ@ View Tools election 9 Help

- =] » E& v E]_Q’. v
R -

Save As ave As C V

e fizan pe se e = storn Outlook  Legacy
)pen & recently used file
M5 Project Flempp -

4

XML

----- Lutiocok

Import Options

SHEMSEAIENS
— | Send Password oject M C:}tEl::I]I: Internet Legacy  Pictures
lg‘ Files and Templates: Open and Save Options Export Options Master/Update Printing
3. Open 5. Password

Choose to open an ex-
isting Chart, Sample

Apply up to a 20 character password to lock a file or to allow

' |:,.|,. | IR >~ LE - the file to be opened as Read-Only without the password.

Chart L Chart .- Chart... Ctrl+0
Upen -

ar ,.or esspn ar | : ﬂ Chart from Internet (FTF)...
(z.zssoaat.ed with the tuto- : | Personal Template... 6. Save As
rials available on the Help 8 Standard Template.. Choose to save as a = 0 o . . .
tab). 0 i late... a3 ; - -

) esandT g o SO Chart, Template, oo E) Chart.
Choose to open a Tem- ' Chart to Merge... or Microsoft Pro B chart to Intemnet (FTP)...
plate over currently 7 sample Chart ’ tect Custom Import DE | Personal Template...

S - u
opened schedule. Stand- ™ Lesson Chart... !rem late P - ) St.andard Tem.glate...
ard templates have been @EI Microsoft Project MPP File... (S i pd | . B Microsoft Project Customn Import Template...
: — - i chedule mus
predesigned. Personal = " vinated | POF...
Templates are ones you ave originate __ |@lHm
P y Llose menu from the Microsoft &
design. . . Save Copy As Version 2008...
L . Project to Mile- :

Chat to Merge open another chart to have it import into the Save Copy As Version 2010...

stones Wizard Save Copy As Version 2012...
Learn more about

the wizard under

the Help /Help Topics).
Save as PDF for easy sharing of your schedule.

Save as HTML to have the Internet Publishing Wizard start-
up. Learn more about the wizard under Help | Help Topics.

bottom of the current opened schedule, best if chart for-
mats are the same.

Open a Microsoft Project File to have the import wizard start
-up. Learn more about the Microsoft Project to Milestones
Wizard under HelpHelp Topics.

Cloze menu

4. Open a Recently Used File

Choose from the listof . 7. Save As PDF
previously used files. §-month EV Report with Stopiights mie H Save as PDF for easy sharing of
You can chose to edit the your schedule.

. . . . 6-month EV Report with Stoplights.mie
list by selecting Edit this |...cn 2 sterter scheduiemie

|iSt. ScheduleLmle

L. . M5 Project Filempp
This is the list that ap- ;<Ed'|tth's it >
pears in the Milestones
Professional Startup Choices dialog box.

8. Import and Export options
Choose from a variety of import and export options. Learn
more about these under Help | Help Topics.
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Getting Started: The File Tab

File = Con

Ed@ Dates Insert Layout@Fo@
PR EH R

M5 Project Filempp -

a by used file

Send

-
@ Files and Templates: Open and Save Options Export Options Printing

11. Microsoft Project Refresh
Refresh a file imported from, or tagged to, a Mi-
crosoft Project or Microsoft Project server file or files.
Build a refresh list for a Milestones files tagged to
multiple Microsoft Project or Microsoft Project Serv-

9. Master Schedule
Choose to combine multiple Milestones schedules.

e o] laese 5 — e
1o . er files.
‘.,m,?m ‘Msm ! Learn more about importing from Microsoft Project
= 2 | under Help | Help Topics.
: - e Multiple Project Summary
° el T T
: Projsct 1 -]
. — ::: A =
— '." “"..., “";..,.“,":" o =
M m T “‘”: ¥ __5 1,

10. Update Master Schedule, Linked Symbols
Choose Master Schedule to update a Master Schedule with
lower level schedules.

Project 1

Symbols can be linked between Milestones charts. To have
linked symbols update choose Linked Symbols. Learn more
about linked symbols under Help | Help Topics.

12. Printing
Choose Printing Options to change the output size, print a specified date range, or exclude columns.

Start  End

Develop Initial Project Plan
Waintsin & Review Froot Plan (LOE)
Waintsin & Review Project Flan |
Maintsin & Review Project Plan 2
Maintsin & Review Frojeot Flan 3

Mainiain & Review Froject Plan (LOE)
& Review Projsct Plan |

Msintsin & Review Proget Pisn §

Maintsin & Review Froject Fian §
Maintsin & Review Froject Fian §
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